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==================================
spColumn v5.50 - Upgraded November 2016
==================================
New Features:
1. Introduced new spSection Module for creating and modifying irregular sections
 Provided advanced and flexible graphical interface
 Provided flexible toolbar with Horizontal/Vertical arrangement and
Small/Medium/Large icon size for easy and fast access to commands and
options
 Provided keyboard and mouse shortcuts for commonly used commands
 Provided 2D & 3D view controls for efficient zooming, panning and rotating
 Provided flexible snap and grid capabilities for accurately creating and
modifying sections
 Provided orthogonal mode for restricting cursor movement to horizontal and
vertical direction when creating or modifying sections
 Provided Undo/Redo capabilities
 Provided commands for On-fly drawing of solids and openings
 Provided capability to combine solids and openings for creating complicated
sections
 Provided capability to select, modify, and add nodes for reshaping sections
 Provided commands for On-fly drawing of different bar patterns
(Single/Linear/Rectangular/Circular)
 Provided capability to draw bars with different cover types (Clear/To bar
center), sizes (Bar size/Bar area), and placements (By numbers/Bar spacing)
 Provided bar cover guide for accurate placement of bars in sections
 Provided settings dialog box to modify various program options and colors
 Provided drawing area dialog box for setting workspace limits and grid lines
spacing
 Provided several selection options (All/Window/Single/Bars only)
 Provided capability to drag shapes and bars to easily rearrange them on screen
 Provided several modification commands (Move/Copy/Rotate/Delete/Mirror)
to create and modify complicated sections
 Provided command to measure distance between two pints
 Provided validate command to check if the section is valid for analysis by
spColumn
 Provided option for highlighting overlapped bars
 Provided option to automatically align the section centroid to coordinate
origin after moving the section to spColumn
2. Introduced new DXF Import/Export Module
 Provided option to automatically find section layer(s)
 Provided option to manually assign Solid/Opening/Bars layers
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Provided options to assign the unit system and unit length of imported section
Provided preview window to show the content of the DXF file
Provided options to turn ON/OFF the layers in preview window
Provided capability to zoom and pan in preview window
Provided options to export the created section in Single/Multiple layers to a
DXF file
Provided option to align the section centroid to coordinate origin while
importing the DXF file
Provided capability to evaluate imported DXF files

Enhancements:
1. Improved 3D failure surface visualization of the P-Mx-My interaction diagram
 Provided advanced and flexible graphical interface
 Provided flexible toolbar with Horizontal/Vertical arrangement and
Small/Medium/Large icon size for easy and fast access to commands and
options
 Modified 2D & 3D view controls for efficient zooming, panning, and rotating
 Modified settings dialog box to change various program options and colors
 Provided option to Hide/Show the pointer
 Modified panel for vertical and horizontal cutting commands
Resolved Issues:
1. Resolved the minor issue related to display of column cross-section in 3D failure
surface visualization
==============================
spColumn v5.11 - Updated July 2016
==============================
Resolved Issues:
1. Corrected the setting of “Concrete ultimate strain” value for non-standard
materials to ensure the strain returns to standard value when user switches back to
standard material.
2. Resolved an issue in v5.10 when user switches from ACI to CSA or vice-versa to
ensure material properties actively match the selected code.
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==============================
spColumn v5.10 - Updated April 2016
==============================
New Features:
1. Added support for CSA A23.3-14 design standard (code) in English and Metric
units
Enhancements:
1. Introduced input value limits for standard and non-standard material properties
respectively
Resolved Issues:
1. Removed the conservative consideration of simultaneous application of minimum
eccentricity about both axes for determination of minimum value of M2 for
biaxial runs per ACI 318, R10.10.6.5
2. Resolved minor issues related to graphical display of P-M Diagram, import of
DXF files, and base file save operations

==================================
spColumn v5.00 - Upgraded December 2015
==================================
New Features:
1. Added support for ACI 318-14 design standard (code) in English and Metric units
2. Introduced a 3D failure surface visualization of the P-Mx-My interaction diagram
including nominal and factored section capacity
Enhancements:
1. Introduced additional validation of concrete maximum stress including user alerts
when non-standard material properties are input.
2. Increased number of factored load entries from 5,000 to 10,000
Resolved Issues:
1. Introduced compression-controlled strain limits for high strength steel
2. Upgrade Design Assistant for compatibility with newer MS Excel 2013
3. Correct location and name of output file in batch mode

============================
spColumn v4.81 - Updated May 2012
============================

Page 3 of 13

www.StructurePoint.org
1-847-966-4357 phone
1-847-966-1542 fax

Resolved Issues:
1. Corrected nominal interaction diagrams for CSA A23.3 standards
2. Updated installation procedure for systems with 64-bit version of Windows 7
=================================
spColumn v4.80 - Updated November 2011
=================================
New Features:
1. Added support for ACI 318-11 code in English and Metric units
Enhancements:
1. Revised calculation of effective length factor, k, for slender columns by
implementing exact formulas used in Jackson and Moreland Alignment Charts
2. Introduced options for EMF files created in batch mode to be named and sorted
by Load Point number
3. Introduced a flag to indicate unexpected axial load capacity increase in transition
zone between Balanced Point and Tension Control for ACI code
Resolved Issues:
1. Corrected value of steel strain corresponding to negative moment for axial loads
2. Removed lower limit of 0.4 on factor Cm in moment magnification calculations
in nonsway frames for ACI 318-08
3. Corrected formatting of spColumn Command Line Help on Windows Vista and
Windows 7
4. Resolved several issues related to program output, installation, and checking for
updates
=================================
spColumn v4.60 - Updated September 2010
=================================
New Features:
1. Added capability to export graphical reports (screen printouts) to EMF files that
can be imported into graphics and word processing software.
2. Introduced a command line parameter used in batch mode to export graphical
reports to EMF files.
Enhancements:
1. Added an option to consider second order effects along the length of a sway
column per ACI 318-08, 10.10.2.2
2. Revised calculation of second order to first order moment ratio for sway columns
designed per ACI 318-08
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3. Revised reporting of second order moments in the program text output to reflect
directly notation used in ACI 318 and CSA A23.3 standards
4. Enhanced program documentation to clarify understanding of ACI 318-08
provisions for slender sway columns
5. Improved consistency in displaying warning messages in the GUI and the text
results report
Resolved Issues:
1. Corrected a few minor issues in formatting of text and graphical output
2. Corrected checking the requirement for moment magnification along length in
sway columns (ACI 318-02/05 10.13.5 and CSA A23.3-94/04 10.16.4.) when
metric unit system is used
==================================
spColumn v4.50 - Upgraded December 2009
==================================
New Features:
1. Added support for ACI 318-08.
2. Added capability to import sections from DXF file.
3. Added capability to show nominal interaction diagrams.
4. Added capability to define percentage of each load type considered as sustained in
calculating slenderness effects for non-sway columns.
5. Added checking of strength and stability of structure as a whole under gravity
loads for slender sway columns per ACI 318-05/02 and CSA A23.3-04/94.
Enhancements:
1. Added capability to display P-M and Mx-My diagrams by selecting number of the
load point coplanar with the diagram.
2. Added examples of input files and Design Assistant spreadsheets for C-shape and
I-shape shear walls.
3. Provided consistent number rounding throughout program interface.
4. Discontinued displaying design and investigation results for slender columns
when applicability of moment magnification method is exceeded.
5. Extended text results report to include:
a. Distance from extreme compression fiber to centroid of extreme
longitudinal tension steel (dt)
b. Minimum clear spacing between longitudinal bars
c. First-order and magnified (second-order) moments for slender columns
d. Maximum steel strain corresponding to section capacity of biaxially
loaded columns
e. Radius of gyration
6. Reformatted text output for increased clarity and consistency.
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7. Revised Manual and Help documentation to increase accessibility, enhance
description of new program features and reflect added functionality.
8. Added default load combinations including Snow load case for CSA A23.3-94.
Resolved Issues:
1. Adjusted minimum clear bar spacing for CSA standards. Previously, more
conservative minimum per ACI was used
2. Corrected capacity calculated for the first load point in Design Mode in case when
the design fails
3. Removed inconsistencies from the disclaimer portion of the results report
4. Printing load point markers outside of interaction diagram area
5. Superimposing interaction diagrams for biaxially loaded sections
6. Saving and opening CTI files that include empty or commented fields in General
Information section
7. Truncating the "col" extensions from data filenames include a dot and renamed
using Save As command
8. Eliminated resetting of strength reduction factors for sections with confinement
OTHER when design code is changed by the user
=============================
spColumn v4.20 – Updated April 2009
=============================
Enhancements:
1. Provided easier and faster access to software manual directly from the Help menu.
2. Modified program to indicate a Warning, in lieu of Error, when convergence issue
is encountered in large sections.
3. Renamed pcaColumn, also formerly known as PCACOL and IRRCOL, as
spColumn to better relate and support the registered trade name of the publisher,
StructurePoint, formerly PCA’s Engineering Software Group.
Resolved Issues:
1. Resolved issue in reinforcement size considered when “sides different” is selected.
2. Reset factors for snow load case to zero in data files created with previous
versions of the spColumn.
3. Resolved issue in reporting the load combinations for section with uniaxial runs.
4. Modified result display to reflect max and min axial capacity accurately when
reinforcement is small
===========================
pcaColumn v4.10 – Updated May 2008
===========================
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Enhancements:
1. Introduced Snow as a primary (Basic) load case
2. Modified default load combinations for ACI 318-05, ACI 318-02, and CSA
A23.3-04 to include Snow load case
3. Implemented functionality to reset load combinations to their default values for
the selected design code
4. Increased program capacity to support:
(a) 10,000 reinforcing bars up from 500
(b) 10,000 exterior points up from 500
(c) 10,000 interior points up from 500
(d) 5,000 factored load entries up from 4000
(e) 50 service load entries
(f) 50 load combinations up from 20
5. Optimized numerical procedures for increased capacity
6. Reformatted display in dialog boxes and text output for increased clarity and
consistency
7. Added functionality to allow user-specified files to save and read user-defined bar
sets
8. Added version information to pcaColumn executable file
9. Discontinued using PCAPROGS.INI file and redirected all user-settings to
Windows registry
10. Updated Manual and Help documentation to reflect added functionality
Resolved Issues:
1. Modified Material Properties dialog box to allow change to specific parameters
without resetting all others (e.g. load combinations, phi factors, and ultimate
concrete strain).
2. Resolved issue with converting earthquake (EQ) loads when unit system is
changed
3. Resolved issue with reading specified strength of concrete (fcp) from a
pcaColumn Text Input (CTI) file
4. Resolved minor functionality issues in several dialog boxes in pcaColumn,
pcaSection, and pcaView
5. Corrected weight of #15 bar in CSA G30.18 bar set
6. Corrected pcaView caption to always display the name of the file that is currently
open
7. Eliminated random occurrence of black screen issue in Investigation mode for
sections without reinforcement

================================
pcaColumn v4.00 - December 2007
================================
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New Features:
1. Added support for ACI 318-05 and CSA A23.3-04 design standards.
2. Added support for batch mode processing via command line parameters.
3. Added pcaColumn Text Input (CTI) files capability.
4. Added capability to export to points from P-M diagrams, Mx-My diagrams, and
3D failure surface.
5. Added capability to export sections in DXF format.
6. Added capability to customize display to include one or both sides of P-M
interaction diagrams.
Enhancements:
1. Provided capability to report neutral axis location and maximum steel strain
corresponding to section capacity.
2. Provided capability to report strength reduction factors in text output.
3. Customization of P-M diagram to show load point labels and splice lines (rays).
4. Provided shortcuts to display P-M and Mx-My diagrams for subsequent load
points.
5. Changed number of bars increment to 1 from 4 in circular column design.
6. Increased filename length (including path) from 128 to 256 characters.
7. Improved handling of Axial Loads including negative increments and enhanced
reporting.
8. Provided explicit export of interaction diagram (IAD) to specified files.
9. Provided capability to check for program updates on-line from Windows or
program environment.
10. Improved security by introducing Digital signature.
11. Updated and enhanced manual documentation to include detailed design code
references.
Resolved Issues:
1. Eliminated “Could not open file mapping object DDE_SVR” error.
2. Eliminated “License is not available” error occurring during solution.
3. Eliminated freezing/crashing of the program in some situations, e.g.
(a) When opening two biaxial files in a row
(b) When solving a section with bars outside of the section
(c) When opening Service Loads dialog box with very large values of loads.
4. Eliminated black screen problem occurring after switching to Investigation mode
from Design mode where no valid design existed.
5. Corrected capacity reduction per CSA A23.3-94 for sections with rho < 1%.
6. Mmin is no longer taken into account for CSA design if slenderness can be
ignored.
7. Factored loads are now always correctly calculated from service loads.
8. Corrected issues encountered in design for reinforcement with fy=87 ksi.
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9. Sections with zero area of concrete are now treated as invalid and cannot be
solved until area of concrete is increased.
10. Report slenderness ratio over 100 always during solution.
11. Resolved bar layout issues encountered with circular columns.
12. Section type is now remembered when switching from Design to Investigation.
13. Iy label is no longer printed instead of Ix in Print Screen printout.
14. Correct units are now displayed in reinforcement Sides Different dialog box.
15. pcaColumn name is now used consistently in the program.
16. Terms “User Defined” and “Other” are now consistently used to designate
Column Type and Confinement.
17. Status bar is now refreshed when a data file is open.
=====================================
pcaColumn - V3.64 - September 9, 2005
=====================================
1. The lshost.txt file now accepts multiple entries. Each entry has to be on a
separate line. License manager will try these entries one by one until a valid
license is found. As an entry, server name, server IP address, “no-net” or “LAN”
can be used. “no-net” means that a standalone license will be used if it is available.
“LAN” will make the license manager look for a license in the local area network
(within the subnet only).
2. The Help | About box displays now detailed licensing information including:
license type, license expiration, license server, and license ID. Licensing
information is also shown in the printouts.
3. Issues with importing data from text files have been resolved.
4. Design for minimum steel area has been corrected.
5. The accuracy of calculating the concrete stress block resultant has been increased.
6. Text results are available for both sides of the P-M interaction diagram if Control
Points or Axial Loads are selected.
7. Results are now cleared if Bar Layout option or Cover To option is changed.
8. A message is now displayed instead of proceeding with a design if Factored Load
or Service Load list is empty.
9. The default value of Stiffness Reduction Factor for slenderness calculations is
now 0.75 instead of 1.0.
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10. The limit value of Service and Factored Loads has been increased to 1.0e12.
11. Superimposed diagrams are now fully shown instead of just one (positive) side.
12. Control point indicators are now shown on both sides of the P-M diagram.
13. Default value of Concrete Strength is now 4 ksi (30 MPa for CSA) instead of 0.
14. Pagination within Service Loads block of text output has been corrected.

=============================
pcaColumn - V3.63 - October 26, 2004
=============================
1. New feature, Bar Selection, in the Design Criteria allows selecting reinforcement
based on either minimum number of bars or minimum reinforcement area. Only
minimum number of bars was implemented in previous versions and it is the
default option in this version.
2. Minor corrections in the text and graphical output were applied.
3. Issues associated with refreshing the Info Window were resolved so that all
current properties of the analyzed section are displayed and printed.
4. Manual, Quick Start Guide, and Help files have been updated.
=============================
pcaColumn - V3.61 - February 18, 2004
=============================
1. For biaxial run, load case numbers are corrected in P-M and M-M diagrams.
===============================
pcaColumn - V3.60 - February 16, 2004
===============================
Modifications:
1. Provides complete P-M diagram.
2. For uniaxial run, calculates resisting moments corresponding to negative applied
moments.
3. For uniaxial run and applied service loads, calculates resisting moments at the top
and the bottom ends of the column.
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4. Provides enhanced reporting of factored and resisting moments.
5. When CSA code is selected, reports the output using the CSA notations.
Bug fixed:
1. For braced columns, the program used to calculate Cm using the portions of M1
and M2 related to dead and live load only. This has been corrected such that Cm
is calculated using the total M1 and M2.
2. For slenderness effect calculations of braced columns, Beta_D used to be greater
1.0 for some load combinations. This has been corrected such that Beta_d is
calculated for a certain load combination as beta_D = (Factored Axial dead
load)/(Total factored axial load) <= 1.0.
===============================
pcaColumn - V3.53 - November 13, 2003
===============================
Bug fixed:
1. Material property strain value range error corrected.

===============================
pcaColumn - V3.52 - November 10, 2003
===============================
Bug fixed:
1. P-M diagram was not plotted correctly for non-symmetric sections when biaxial
run-option was selected.
2. Printing problem on Windows 98.
Changes:
1. Specifying the rupture strain of the reinforcing steel is no longer available in
pcaColumn. Rupture strain will be always assumed to be equal to infinity.

=============================
pcaColumn - V3.51 - October 23, 2003
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=============================
1. During startup of pcaColumn v3.50 on Windows NT 4.0 pre SP4, an error
message was displayed - "GetLongPathNameA could not be located in
KERNEL.DLL". It has been fixed.

========================================
pcaColumn - V3.50 - September 2003 (32 bit release)
========================================
General:
1. Program has been upgraded to 32 bit windows environment.
2. Program name changed to pcaColumn.
3. Includes Column+ for irregular column analysis (pcaSection module, formerly
IRRCOL module).
4. Program reads data files from version 3.0 and 3.0b. Choice is given to interpret
lateral load as wind or earthquake load.
5. Licensing software protection incorporated in the program.
Improvements and New features:
1. Program supports ACI 318-02 and CSA A23.3-94.
2. Number of load cases increased to 4 (Dead, Live, Wind, and Earthquake).
3. Number of service load entries increased to 50.
4. Number of load combinations increased to 20.
5. Number of factored load entries increased to 4000.
6. Number of points defining section increased to 500.
7. Number of points defining the opening in a section increased to 500.
8. Keyboard shortcuts added for most commonly used menu items.
9. Recent files list added to the File menu.
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10. "Copy Diagram to Clipboard" command added to the View menu.
11. Printout can be directed to any available printer (not the default only).
12. Separate command for printing text results and graphics.
13. Colors added to the main window and toolbar icons.
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